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| System Overview
I The SA-2U product

The SA-2U is a resolution independent safe area generator designed to operate
independently of frame rate and interlaced/progressive transports and should
work with the following image rasters.

Single link 4:2:2 SD 720x576 & 720x480
Single link 4:2:2 HD 1280x720 & 1920x1080
Dual link HD 4:4:4 1920x1080 & 2048x1080

For dual link standards the unit support 10 or 12 bit operation in YCbCr or RGB
colour spaces and 100%, 200% or 400% dynamic range.

The SA-2U can display up to 4 simultaneous safe-areas/cursors and each safe-
area/cursor has independent controls for style, colour and opacity. All safe-areas
have independently controllable centre markers.

The SA-2U firmware is field re-programmable and all the defined safe-areas are
user programmable to ensure that the unit stays up to date with emerging
standards.

.2 Associated Equipment for the SA-2U

The SA-2U processing card requires the following in order to set up and operate
the unit.

1. An etherBox chassis (FB-9€). Up to six SA-2U units and be installed
in one chassis.

2. A flexiPanel control surface such as an FP-9 or an FP-IO.

etherBox
by eyeheight

Figure 1 - Front view of etherBox (FB-9€) fitted with FF9 blank panel
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P-9 flexiPanel can be fitted on the FB-9€ or remotely using an RR-9 kit.
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o

Figure 2
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2 Installation.

This unit requires HD-SDI or SDI digital video connections to the BNC
connectors. Optionally RS232, GPI's and a Tally may also be connected normally
using CAT5e cable. The user should refer to the etherBox user manual for
installation of the SA-2U into a chassis and connection of flexiPanels. This will
also describe the process of acquiring a processing card (in this case the SA-2U)
by the flexiPanel which is necessary to access the menu structure within the SA-
2U.
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Figure 3 - Connections to the SA-2U

For single link standards only Link A In is required. For single link standards the
unit has 3 outputs via Link A Out 1, Link A Out 2 and Link B Out.

For dual link standards Link A In and Link B In are required. For dual link
standards the unit has one output via Link A Out 1 or Link A Out 2 and Link B
Out.

For applications where SMPTE352 Video Payload Identification packets are not
present in the input video it may be necessary to manually configure the input
mode for proper operation. See section 3.4 for details.

See Section 5.1 for details of the GPI/Tally/RS-232 pinout.

-7-
eyeheight Unit 34 Park House Watford Business Park Greenhill Crescent Watford Herts GB WD18 8PH
Reg. No. 2855535 Telephone: +44 (0) 1923 256 000 Fax: +44 (0) 1923 256 100 email: eesales@eyeheight.com



3 Operation

All geN€Tics products are controlled using a generic menu system. This generic
menu system is operated from a generic panel (flexiPanel FP-9 or FP-10). An
FP-9 is shown below (An FP-IO has the same controls in a different layout style).
For information about acquiring processor cards for control on a flexiPanel see
the etherBox manual section 4.

3.1 General flexiPanel control

Device Buttons with
LEDS are used to
switch from one

5 ard
processing card lo MNEXT menu

Button

eyeheight™

PS2
Keyboard
Connector

PREV menu
Menu Windows Button Rotory Digipots

AB.C,D display 4 AB,C.D with LEDS,
. m:nus ata hn?e These are used to

ach menu can have change parameters in

up to 3 parameters the menu windows,

Figure 4 flexiPanel (FP-9) controls.

3.1.1 Device buttons

There are 8 grey device buttons. These switch between the currently selected
processing cards installed in the etherBox. It is also possible to select cards in
another chassis if the I-Bus is connected to the other chassis.

3.1.2 Menu navigation
There are two ways to navigate from menu to menu.

1. Using the NEXT ane PREV buttons. These are for “Flat” menu structures.
The NEXT and PREV LEDS will flash while further menus are available.

2. Using a LCD button (as below coloured orange).
This is more common and will take you straight to a relevant set of menus.
Examples are the and menu’s shown on Figure 8.

GOTO SINGLE
ANOTHER PARAMETER INFORMATION
DISPLAY

MENU ADJUSTMENT

Figure 5 Types of menus showing their characteristic colours
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3.1.3 Parameter adjustment of a menu

A green menu is one in which there is only one adjustable parameter. There are
two ways to adjust the parameter in a green menu.

1. Press the green LCD button. This will increment the value in that window.
This is most frequently done when the menu parameter is Textural for
example switching a parameter between ON and OFF. In this case a
button press is most natural.

2. Use the Rotary digipot (A,B,C or D) to adjust the parameter in the
respective LCD window (A,B,C or D). The direction and speed of rotation
enable numeric values to be set easily.

3.1.4 Parameter adjustment of a red menu

A red menu is one in which there is two or three adjustable parameters. In this
case it is necessary to first select the menu by pressing the red button. When the
red button is pressed it will turn green and either two or three of the rotary digipot
LEDS will flash indicating that the respective rotary digipot will operate the
respective parameter.

3.L.5 Information display

A Yellow menu (Which on most panels does look a light orange!) is one in which
only information is displayed. An example of this is the software version display.

3.2Primary safe-area generator control

The top level menu shown below gives direct access to the configuration menus
for the three primary safe-area generators.

Pressing the “Next button” will take you to the menus for the special purpose
cursor generator, input status and source configuration and memories. See
sections 3.3, 3.4 and 4 for further details.

The Master Control menu operates across all cages and special purpose screen
utilities and will allow them to be shown or will hide them.

The three primary safe-area generators operate identically and are composited
onto the input video as separate layers each with independent colour and
opacity. Cage 1 is the lowest layer and Cage 3 is the highest.

Pressing any of the “Cage” menus will display the menus below
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Name 1 | Cursor | Colour
Name 2 | Style= | Alpha
Stndrd | off Centre

In the first menu “Name 17, “Name 2” will be replaced by the names defined for
the currently selected safe-area when the safe areas were configures in the cage
uploader application, “Stndrd” will be replaced by the name defined for the
currently detected raster as configured in the cage upload application. For details
of the operation of the cage uploader application see section Error! Reference
source not found..

The “Cursor Style=" menu can be used to select the preferred display mode for
the current safe-area.

Mode | Result

Off The safe-area is not displayed

Dash1 | The safe-area is displayed as a single pixel/line wide dashed line

Dash2 | The safe-area is displayed as a double pixel/line wide dashed line

Thick | The safe-area is displayed as a double pixel/line wide line

Thin The safe-area is displayed as a single pixel/line wide line

Solid The area outside the safe area is coloured

In all cases the colour of the display and the opacity can be configured via menus
accessed by pressing the “Colour Alpha Centre” menu.

N.B. For interlaced displays selecting “Dash1” or “Thin” may result in horizontal
lines that flicker. For 4:2:2 interfaces selecting “Dash1” or “Thin” may result in
vertical lines which do not accurately reflect the selected colour due to
chrominance sub-sampling.

Pressing “Back” will return to the top level cage menus.
Pressing the “Colour Alpha Centre” menu display the menus below

Colour | Alpha

The "Colour” menu allows the user to select the colour for the current safe area
generator for a set of standard colours (white, yellow, cyan, green, magenta, red,
blue, black).

The “Alpha” menu allows the user to specify the opacity for the current overlay.

N.B. The safeEyes4:4:4 holds two independent values for alpha for each safe-
area, one used when the display mode is “Solid” and another for all other display
modes. This provides an improved user experience when switching between the
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solid and line display modes and is largely transparent to the user as only the
appropriate alpha is displayed and adjusted.

The “Centre” menu allows the user to turn on or off the centre marker for each
safe-area independently. The centre marker is automatically sized depending on
the size of the selected safe-area and will automatically display as either a single
or double line depending on the height and width of the safe area so as to most
accurately indicate the centre.

Pressing “Back” will return you to the previous menus.

3.3 Special purpose cursor generator control

The special purpose cursor provides real-time user configurable safe-area, text
height measurement, pixel strobe, cursor functionality and onscreen aspect ratio
information. The special purpose cursor layer is composited on top of the primary
safe-area layers.

Pressing the “Next” button (to the immediate right of the right-most menu button)
from the top level menu then “Special screen utils” displays the menus below.

Box | Strobe

Style ]
colour |Display

Pressing the “Alpha Style Colour” menu displays the menus detailed in section
3.3.1. Pressing “On Screen Display” displays the menus detailed in section 3.3.2.
Pressing “Box” displays the menus detailed in section 3.3.4. Pressing “Strobe”
displays the menus detailed in 3.3.6. Pressing the “Next” button (to the immediate
right of the right-most menu button) displays the menus shown below.

_Ursor

Pressing “Cursor” displays the menus detailed in section 3.3.6. Pressing the
“Text ABC” menu displays the menus detailed in section 0. Pressing the “Back”
menu takes you back to the top level menus.

3.3.1 Special purpose cursor display options

Colour | Alpha |Cursor
Style=
Thin

Blue
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The "Colour” menu allows the user to select the colour for the current safe area
generator for a set of standard colours (white, yellow, cyan, green, magenta, red,
blue, black).

The “Alpha” menu allows the user to specify the opacity for the special purpose
cursor overlay.

The “Cursor Style=" menu can be used to select the preferred display mode for
the special purpose cursor when used to display the user box. This menu is
overridden for all other special purpose cursor functions.

Mode | Result

Dash1 | The user box is displayed as a single pixel/line wide dashed line

Dash2 | The user box is displayed as a double pixel/line wide dashed line

Thick | The user box is displayed as a double pixel/line wide line

Thin The user box is displayed as a single pixel/line wide line

Solid The area outside the user box is coloured

3.3.2 On Screen Display

Onscrn | Aspect | Aspect
Text= |Type= |Ratio=
Medium | Both

When the user box is turned ON the aspect ratio details for the user box will be
displayed on screen. The calculations using a denominator of 9 are as follows:

PAL: 702 x 576 (Pixels 0 to 701 x Lines 1 to 576) user box, pixel aspect ratio =
1.09401. Ratio = 12/9 on a 4:3 glass and 16/9 on a 16:9 glass.

NTSC: 704:480 (0 to 703 x 1 to 480) user box, pixel aspect ratio = 0.90909. Ratio
=12/9 on a 4:3 glass and 16/9 on a 16:9 glass. HD pixels aspect ratio = 1.

“Onscrn Text” allows the user to select the size of the characters for the aspect
ratio calculation text, if the user box is turned ON, or to hide the onscreen
information by selecting OFF.

“‘Aspect Type” allows the user to select which lines of aspect ratio calculation text
are displayed on the screen if the user box is turned ON.

The “Aspect Ratio” menu allows the user to select the denominator (usually 1, 3
or 9) to be used for the aspect ratio calculation text which will be displayed on the
screen if the user box is turned ON.

The aspect ratio calculation text displayed on the screen will be similar to the
example shown below, user box = 150 to 570 x 100 to 475, denominator = 9.

ASPECT RATIO
11.02/9 STND  4:3 glass using a denominator of 9
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14.70/9 WIDE 16:9 glass using a denominator of 9
With HD video, STND will always be 0.00 because only WIDE is relevant . STND
could be hidden using “Aspect Type” as explained above.

3.3.3 Text height measurement

TEXT
HEIGHT
OFF

Pressing the first button or adjusting digi-pot 1 will toggle the visibility of the text
height measurement cursor. If another special purpose cursor is being displayed
it will be removed. The text height measurement cursor displays a horizontal
opaque stripe across the full width of the image. The “Adjust” menu is red to
indicate that it is an unopened nested menu. Pressing the “Adjust” menu will
open it (the “Adjust” menu will turn green and the first “TEXT HEIGHT” menu will
go red) The A value can no be adjusted using the first digi-pot and the B value
can be adjusted using the second. Align the top and bottom of the opaque band
with the top and bottom of the text to be measured and read of the text height in
lines from the third menu. The “Adjust” menu can be closed by pressing any of
the menu buttons.

3.3.4 User Box

BoxOff
S1.000
wl.333

Pressing the first menu button or adjusting digi-pot 1 will toggle the user box
display through Off, On and On+ which displays the user box and its centre
marker. If another special purpose cursor is in use it will be removed. The W and
S values indicate the aspect ratio of the user box when viewed in standard aspect
ratio (4:3) and widescreen aspect ratio (16:9). For HD signals only the W value is
active.

The position and size of the user box can be adjusted by opening the “Sides:”
and “TopBot” menu by pressing them and then adjusting using digi-pots 1 and 2.

3.3.5 Strobe

LinPix | L=250
STROBE
OFF
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Pressing the first menu button or adjusting digi-pot 1 will toggle the strobe on and
off. If another special purpose cursor is being displayed it will be removed. The
selected line and pixel can be adjusted using digi-pots 2 and 3.

3.3.6 Cursor

CURSOR
IS
OFF wl.333

Pressing the first menu button or adjusting digi-pot 1 will toggle the cursor on and
off. If another special purpose cursor is being displayed it will be removed. The
width and height of the cursor can be adjusted by opening the “Adjust” menu and
using digi-pot 1 and 2. The W and S values indicate the aspect ratio of the user
box when viewed in standard aspect ratio (4:3) and widescreen aspect ratio
(16:9). For HD signals only the W value is active.

3.4Input status and source configuration

For sources which do not contain SMPTE352 video source identification packets
the input status must be manually configured.

From the top level menu shown above press the “Next” button (to the immediate
right of the right-most menu button) to display the menus below.

E §§§¥ Inpukt | Mems
Resets
LLCIS otatus Upgrde

Now press “Input Status” to be taken to the input status and source configuration
menus as shown below.

Mode= |Link= |Resltn | Next->
_ H= *BACK*
Auto Single | v=

Pressing the Mode button will toggle between “Auto”, which will attempt to

automatically configure the input mode based on detected SMPTE352 packets,
and “Manual” mode which allows the user to manually specify the link type and
subsequent settings. In “Auto” mode all source configuration menus are locked.
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The “Resltn” menu displays the detected input resolution which is used by the
sefeEyes4:4:4 to select the set of safe areas that the user can select. For a safe
area to be available the resolution it was designed for must match the detected
input resolution.

Pressing the “next” button (to the immediate right of the right-most menu button)
will display the menus below which can be used to configure the subsequent
input parameters.

Colour
Mode=
YCbCr

*BACK*

For “Link = Single” all other source configuration are locked as shown above.
Selecting “Link = Dual” will allow either RGB or YCbCr to be selected in the
“Colour Mode” menu and either 10b or 12b to be selected in the “Bit Depth”
menu. With “Bit Depth = 12b” selected the “D.Rnge” menu can select 100%,
200% or 400% dynamic range.

3.5 Memories

3.5.1 User Memories

The user memories are a generic feature of all eyeheight geN€Tics products. Six
of these are included in the SA-2U. Only the menu parameters shown in RED are
saved.

The selected cages can be saved but will only be restored if the
current video standard is the same as when the memory was saved.
If the video standard has changed the first cage available for the
current standard will be selected.

3.5.2 Naming User Memories

The user memories can be named with up to 6 characters. To do this plug in a
PS-2 Keyboard into a flexiPanel and select the appropriate processor card with a
device button. (See Figure 5 for connector location). To name memory 1,
“TXroom”

1. Hit F9 function key. The LCD displays will change to text entry mode
2. Type “M01:TXroom” and then press enter.
3. You may get a “not acknowledged” message, this does not matter.

Other memories can be named in the same way but changing the 01 to another
memory number.

3.5.3 Power on memory

This product will restore the settings that were current when the “Set As Pow On
Memory” menu button was pressed with the same limitations as for User
Memories.
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3.6 Tamper Locking the SA-2U.

The user can lock specific menus or all the menus on the SA-2U so that it cannot
be adjusted with a manual control panel. This does not affect automation.

To do this plug in a PS-2 Keyboard into a flexiPanel and select the appropriate
processor card with a device button. (See Figure 5 for connector location). To
lock only menu 5. (Next Logo for channel A)

1. Hit F9 function key. The LCD displays will change to text entry mode
2. Type “L05:” and then press enter.

A padlock symbol will appear on the menu and it cannot be adjusted. To unlock
menu 5, type “A05:” as step 2 above. Other menus are done in the same way

To lock the whole product type “L:” as step 2 above and to unlock the whole
product type “A:” as step 2 above.

3.7 GPI/Tally Set-up.

3.7.1 On-Board GPI's

The SA-2U is a geN€Tics product. The geN€Tics system uses generic
Input/Output cards which have 3 GPI's and one Tally output. These have been
used in this system as opportunistic GPI’'s which may be of use to the user. They
do not provide a comprehensive GPI control but may be used as part of a GPI
solution in conjunction with the GPI’s on the etherBox.

The operation of the two GPI’s used is explained in the table below.

Table 1 - On-Board GPI settings

GPI1 GPI2 GPI3 Effect
OFF 1 1 1 The GPI's have no effect
Master Hide 0 1 1 All cages will be hidden.
Master Show 1 0 1 Selected cages will be displayed.

0=Short to ground or logic 0V, 1=Pulled up internally or logic +3->+12V

3.7.2 On-Board Tally
The single tally output has two modes:

1. Indicate that one or more cages are being displayed.
2. Indicate that no cages are being displayed..

The operation of these is explained in the table below.
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Table 2 - On-Board Tally settings.

Tally Meaning
State
ON 0 A cage is being displayed
OFF 1 No cages are being displayed

O=Transistor ON, shorting to ground, 1=Transistor OFF, open.

3.7.3 Configuring tallies on the etherBox.

The SA-2U can also make use of the three configurable tallies on the etherBox
chassis. The etherBox chassis has three usable tallies. These are 11,12 and 13.
Set up these menus for the box number and tally number for channel A and
channel B. If you do not wish to use a tally set the box number to 0. Refer to the
etherBox man
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4 The SA-2U Menu Set.

The following set of menus defines the operational controls of the sa-2u.

Note: Only parameters with RED menu numbers are stored in the memories and
the Power-ON memory.

Menus 00-03 Top Level Menus

Master

contr1 ||[C2oe|| ||[C2oe]| ||[<2oe
= Show

Menu Num. | Heading Function

0 Hide/Show | Setting this menu to “Hide” will hide all
the cages, strobes and cursors etc.

1 Cage 1 Press this button to take you to the
Cage 1operational control menus
(Go To Menu 8).

2 Cage 2 Press this button to take you to the
Cage 2 operational control menus
(Go To Menu 16).

3 Cage 3 Press this button to take you to the
Cage 3 operational control menus
(Go To Menu 24).

Pressing the “NEXT” button while the Top Level Menus are displayed will
take you to menus 04-07.

Menus 04-07 Menus

Special
e | Status | Resets

LICII%

Menu Num. | Heading Function
4 Special Press this button to take you to the User
screen Box, Text etc. operational control menus
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utils (Go To Menu 32).

5 Input Press this button to take you to the Input
Status Status operational control menus
(Go To Menu 60).
6 Mems, Press this button to take you to the

Resets, Tally, Memory, Reset and Upgrade
Upgrde operational control menus
(Go To Menu 108).

7 Back Press this button to take you back to the
Top Level Menus (00-03).

Menus 08-11 Menus Cage 1

16:9
S.Actn | Style=
10801 |off

Colour
Alpha
Centre

Menu Num. | Heading Function
8 Cage = Use this menu to select a cage from a
See 3.5 Variable list of cages that have been created for

depending | the detected video standard.
on video
standard

9 Style 0-5 Use this menu to select the desired
Off cage style.
Dash 1
Dash 2
Thick
Thin
Solid

10 Colouir, Press this button to take you to the
Alpha, Colour, Alpha and Centre operational
Centre control menus

(Go To Menu 12).

11 Back Press this button to take you back to
the Top Level Menus (00-03).

-19 -
eyeheight Unit 34 Park House Watford Business Park Greenhill Crescent Watford Herts GB WD18 8PH
Reg. No. 2855535 Telephone: +44 (0) 1923 256 000 Fax: +44 (0) 1923 256 100 email: eesales@eyeheight.com



Menus 12-15 Menus Cage 1

Colour |Alpha |Centre | Barck
white | 75% off —

Menu Num. | Heading Function

12 Colour Use this menu to select a colour for the
0-7 selected cage.
White
Yellow
Cyan
Green
Magenta
Red
Blue
Black

13 Alpha % | Use this menu to select the desired
0-128 opacity of the cage.

14 Centre Use this menu to select whether the
0-1 centre marker of the cage is to be
Off displayed.
On
15 Back Press this button to take you back
Menus 08-11.

Menus 16-19 Menus Cage 2

16:9
S.AcCtn
10801

Colour
Alpha
Centre

Menu Num. | Heading Function

16 Cage = Use this menu to select a cage from a
Variable list of cages that have been created for
depending | the detected video standard.
on video
standard

17 Style 0-5 Use this menu to select the desired
Off cage style.
Dash 1
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Dash 2

Thick
Thin
Solid
18 Colour, Press this button to take you to the
Alpha, Colour, Alpha and Centre operational
Centre control menus
(Go To Menu 12).
19 Back Press this button to take you back to

the Top Level Menus (00-03).

Menus 20-23 Menus Cage 2

Colour | Alpha

Centre

of f

Menu Num. | Heading Function

20 Colour Use this menu to select a colour for the
0-7 selected cage.
White
Yellow
Cyan
Green
Magenta
Red
Blue
Black

21 Alpha % | Use this menu to select the desired
0-128 opacity of the cage.

22 Centre Use this menu to select whether the
0-1 centre marker of the cage is to be
Off displayed.
On
23 Back Press this button to take you back to
Menus 08-11.
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Menus 24-27 Menus Cage 3

16:9 Cursor | Colour | Bark

S.Actn | Style= | Alpha
108071 |off Centre —

Menu Num. | Heading Function

24 Cage = Use this menu to select a cage from a
Variable list of cages that have been created for
depending | the detected video standard.
on video
standard

25 Style 0-5 Use this menu to select the desired
Off cage style.
Dash 1
Dash 2
Thick
Thin
Solid

26 Colouir, Press this button to take you to the
Alpha, Colour, Alpha and Centre operational
Centre control menus

(Go To Menu 12).

27 Back Press this button to take you back to
the Top Level Menus (00-03).

Menus 28-31 Menus Cage 3

Colour |Alpha |cCentre | Bark
white | 75% off —

Menu Num. | Heading Function

28 Colour Use this menu to select a colour for the
0-7 selected cage.
White
Yellow
Cyan
Green
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Magenta
Red
Blue
Black

29 Alpha % | Use this menu to select the desired
0-128 opacity of the cage.

30 Centre Use this menu to select whether the
0-1 centre marker of the cage is to be
Off displayed.
On
31 Back Press this button to take you back to
Menus 08-11.

Menus 32-35 Menus User Controls.

Box | Skrobe

Skvle _
Zalodr | Displaw

Menu Num. | Heading Function

32 Alpha, Press this button to take you to the
Style, Colour, Alpha and Centre operational
Colour control menus for the User Box

(Go To Menu 40).

33 On Press this button to take you to the On
Screen Screen Display menus (Go To Menu
Display 112).

34 Box Press this button to take you to the User

Box menus (User definable cage)
(Go To Menu 48).

35 Strobe Press this button to take you to the
Strobe menus (Go To Menu 52).

Menus 36-39 Menus User Controls

Cursar | Texk Back,

BET N

-23-
eyeheight Unit 34 Park House Watford Business Park Greenhill Crescent Watford Herts GB WD18 8PH
Reg. No. 2855535 Telephone: +44 (0) 1923 256 000 Fax: +44 (0) 1923 256 100 email: eesales@eyeheight.com



Menu Num. | Heading Function

36 Cursor Press this button to take you to the
Cursor operational control menus (Go
To Menu 56).

45 Text Press this button to take you to the Text
Height control menus (Go To Menu 44).

46

47 Back Press this button to take you back to

Menus 32-35.

Menus 40-43 Menus User Controls

Centre

off

Colour | Alpha

Menu Num. | Heading Function

40 Colour Use this menu to select a colour for the
0-7 User controls.
White
Yellow
Cyan
Green
Magenta
Red
Blue
Black

41 Alpha % | Use this menu to select the desired
0-128 opacity of the user controls.

42 Cursor Use this menu to select whether the
Style 0-4 | centre marker of the cage is to be
Thin displayed.
Thick
Dash1
Dash2
Solid

43 Back Press this button to take you back to
Menus 32-35.
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Menus 44-47 Menus User Controls

TEXT
HEIGHT
OFF
Menu Num. | Heading Function
44 Text Use this menu to turn the text height
Height reference lines on or off.
0-1
OFF
ON
45 Text Top | Use this menu to select the desired
/ Bottom | position of the top and bottom reference
lines. Position the top line to the top of
the text to be measured and the bottom
line to the bottom of the text.
46 Text This menu shows the height of the text (
Height the distance between the top and
bottom reference lines) in Video Lines.
47 Back Press this button to take you back to
Menus 32-35.

Menus 48-51 Menus User Controls

BoxOff
S0.000
wl.116

Menu Num. | Heading Function

48 Box 0-2 | This Menu allows you to select whether
BoxOff the User Box will be off, on or on and
Box On with centre marker on.
BoxOn+ | The S and W values give the aspect
ratio of the User Box. S = Standard, W =

Wide Screen.
49 Left/ This menu allows you to position the
Right Left and Right sides of the User Box.
50 Top / This menu allows you to position the
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Bottom Top and Bottom of the User Box.

51 Box This menu allows you to quickly re-
Position position the User Box on the screen.

Menus 52-55 Menus User Controls

LinPix | Line =
STROBE | 250

Menu Num. | Heading Function
52 Strobe This Menu allows you to select whether
0-1 Strobe will be off, or on.
OFF The strobe can be used to locate the
ON line and pixel position of a position on
the screen.
53 Line This menu allows you to position the line
position of the strobe.
54 Pixel This menu allows you to position the
pixel position of the strobe.
55 Back Press this button to take you back to
Menus 44-47.

Menus 56-59 Menus User Controls

CURSOR
IS
OFF
Menu Num. | Heading Function
56 Cursor This Menu allows you to select whether
0-1 Strobe will be off, or on.
OFF The strobe can be used to locate the
ON line and pixel position of a position on
the screen.
57 Adjust This menu allows you to position the line
position of the strobe.
58 Blank This menu allows you to position the

pixel position of the strobe.
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59

Back

Press this button to take you back to
Menus 44-47.

Menus 60-63 Menus Input Status

Menu Num.

60

61

62

63

Heading

Mode O-
1

SMPTE
352

MANUAL
Link

If in
MANUAL
mode

0-1
Single
Dual

Resolution

Back

hext -
*BACK*

v=1080

Function

This Menu allows you to select whether
Link, Colour Mode, Bit Depth and
Dynamic Range will be interpreted
from the SMPTE 352 packet or set
manually by the operator.

This menu allows you to select Single
or Dual Link Mode if Menu 60 is set to
MANUAL.

Will indicate the link mode if SMPTE
352 packets are being received.

This menu displays the Horizontal and
Vertical resolution of the detected
video standard.

Press this button to take you back to
Menus 04-07. Press the “NEXT” button
to take you to Menus 64-67.

Menus 64-67 Menus Input Status

Menu Num.

64
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Colour
If in

Function

This menu allows you to select YCbCR
or RGB Colour Mode if Menu 60 is set
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MANUAL | to MANUAL and Menu 61 is set to
mode Dual.
0-1
YCbCr Will indicate the colour mode if SMPTE
RGB 352 packets are being received.

65 Bit Depth | This menu allows you to select 10 Bit
Ifin or 12 Bit Depth if Menu 60 is set to
MANUAL | MANUAL and Menu 61 is set to Dual.
mode
0-1 Will indicate the Bit Depth if SMPTE
10b 352 packets are being received.
12b

66 Dynamic This menu allows you to select 100%,
Range 200% or 400% Dynamic Range if
Ifin Menu 60 is set to MANUAL, Menu 61
MANUAL | is set to Dual and Menu 65 is set to 12
mode Bit.
0-2
100% Will indicate the Dynamic Range if
200% SMPTE 352 packets are being
400% received.

67 Back Press this button to take you back to

Menus 60-63.

Menus 72-75 Menus For Automation
These menus allow automation control of cages 1, 2 and 3.

They are similar to Menus 8, 16 and 24 except that they are not dynamic but
contain all the cage types held in memory whereas Menus 8, 16 and 24 are

dynamic and only contain the set of cage types relevant to the current video
standard.

If a cage is selected that is relevant to the current video standard input then that
cage will be displayed and the automation menu value will change to the selected
cage.

If a cage is selected that is not relevant to the current video standard input the
displayed cage will not change and the automation menu value will not display
the requested menu value.

The variable values are 0-99 where 0 = Cage 1 and 99 = Cage 100.

If user defined cages have been uploaded using the “CageUploader” software
use “Tools” -> “Save list of cages” to generate a full list of the available cages.

Refer to sections 5.3, 5.4 and 5.5 for more information.
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Menus 76-91 User Memories

Back.

Mem 1 |[Mem 2 [Mem 3 —_—
Recall |Recall |Recall
Menu Num. | Heading Function
76 MEM1 Pressing this will recall Memory number
1. User Names can be programmed in
to the memories using a keyboard. See
“geNETics User guide”, section “Giving
product Memories names”
77 MEM2 Pressing this will recall Memory number
2.
78 MEM3 Pressing this will recall Memory number
3.
79 BACK Go to Menu 04-07
Mem 4
Recall |Recall |Recall
Menu Num. | Heading Function
80 MEM4 Pressing this will recall Memory number
4.
81 MEMS Pressing this will recall Memory number
5.
82 MEM®6 Pressing this will recall Memory number
6.
83 BACK Go to Menu 04-07

Menu Num. | Heading Function
84 SAVE Pressing this will Save Memory number
MEMA1 1.
85 SAVE Pressing this will Save Memory number
MEM2 2.
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86 SAVE Pressing this will Save Memory number
MEM3 3.

87 BACK Go to Menu 04-07

Menu Num. | Heading Function

88 SAVE Pressing this will Save Memory number
MEM4 4.

89 SAVE Pressing this will Save Memory number
MEM5 5.

90 SAVE Pressing this will Save Memory number
MEMG6 6.

91 BACK Go to Menus 04-07

Menus 92-95 Reset Menus

Set As | ReBoot | FACTRY
Pow On RESET!

Memory Frrrn
Menu Num. | Heading Function
92 Set as Pressing this will set the current settings
See 3.5 Power as the default settings when the unit is
on powered up. This only applies to menus
Memory | whose menu number is in RED.
93 Reboot This applies a warm restart to the unit. It
this unit | is the software equivalent of recycling
the power.
94 Factory Pressing this will take you to the Factory
Reset Reset Last Chance menu. (Go To Menu
44).
95 BACK Go to Menus 04-07
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Menus 96-99 Reset Confirmation Menus

START? | ARE->

Menu Num. | Heading Function

96 - -

97 -—-- -—--

98 YES, | This will Start a factory Reset of the unit.
want to This will Wipe ALL Cages and Settings
do a that may have been previously set-up.
factory Only do this if you are setting up from
reset! scratch, or there is a problem with your

unit.

99 BACK Go To Menus 04-07

Menus 100-103 Resets and Software Upgrade Menus

UPGRDE | SA-2U RESETS
SOFTWR | 170609

Menu Num. | Heading Function

100 Upgrade | Pressing this will take you to the
Software | Software Upgrade last chance menu.
(Go To Menu 104).

101 Software | This window displays the software
Version version.
102 Resets Pressing this will take you to the Reset
Options. (Go To Menu 92).
103 BACK Go to Menus 04-07

Menus 104-107 Software Upgrade Confirmation Menus

START? | ARE->

Menu Num. | Heading Function
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104

105 -—-- e
106 YES, | This will Start a software upgrade of the
want to unit. You will need to follow the
start a instructions in the etherbox (FB-9E)
software | manual or the “Flasher User Manual” to
upgrade | correctly perform this procedure. This
will Wipe ALL Logos and Settings that
may have been previously set-up. The
unit MUST be installed in an FB-9E to
perform an upgrade.
107 BACK Go to Menus 04-07

Menus 108-111 Menus Tally, Memories, Reset and Upgrade

R,

Upgrade

Menu Num. | Heading Function
108 Cage If a cage is displayed a tally will be set.
Tally This menu allows you to select the Box

Box 0-16 and the tally Number that will indicate
Tally 0-99 | this.

109 Memories | Pressing this will take you to the User
Preset-able Memories Menus 76 - 91
110 Upgrade, Pressing this menu will take you to the

Reset and | Upgrade, Software Version and Reset
Software Menus 100 - 103
Version.

111 Back Go to Menus 04-07.

Menus 112-115 Menus Tally, Memories, Reset and Upgrade

Medium | Both

Menu Num. | Heading Function
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112 Onscreen If the user box is on, this menu

Text allows the text size to be altered.
0-3
Off See section 3.3.2 for more details
Small
Medium
Large
113 Aspect Type | If the user box is on, this menu
0-2 allows the lines of text to be
Both displayed
Stndrd (4:3)
Wide (16:9)
114 Denonimator | If the user box is on, this menu
1-15 allows the denominator to be chosen
115 Back Go to Menu 32.

Menus 116-119 No Video Input Info Menus

Menu Num. | Heading Function
112 - This is a system message. If the card
loses the video signal this message is
displayed.

Menus 116-119 Upgrade Info Menus

LI-1D IS UPG | RADING | IF NO
FILE IS REC | TEVED
OUT IN | 3 MINS

Menu Num. | Heading Function

116 -—-- This is a system message. If you press
“Software Upgrade” then this message
appears. If you have done this
accidentally, simply WAIT 3 minutes and
the system will return back to normal.
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5 Technical Appendix
5.1 GPI/Tally/RS232 technical information.

The Processor card has an RJ-45 connector with GPI, Tally and RS232
connections as shown below:

GPI-1 White/Orange
GPI1-2 Orange

GPI-3 White/Green
GND Blue

RS232 TX | White/Blue
RS232 RX Green

Not Used White/Brown

0 N g~ wW NP

Tally (open | Brown
collector)

Table 3 GPI/Tally and RS232 pin-out on RJ-45.

5.1.1 GPI Inputs.

== 33W0LTS

DIODES

R
|:| 100K *
<TEHT»

USER GFI INPIT =} ____F =] TO GPFI PROCESS0OR

Figure 6 Typical GPI Input

GPI's are normally activated by a short to ground. The GPI has its own internal
pull-up resistor. If the user is interfacing with logic then

e Vhigh = +12V>Vin>+3V
e Viow = +0.3V>Vin>0V
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5.1.2 Tally Output.

<> USER OUTPUUT

I

R TR
TALLY PROCESSOR BC817-16
330R

o

Figure 7 Tally Output

The user Tally Output is an open collector transistor. The drain should be
<200mA. An electro-mechanical relay can be operated by this as shown in the
example below.

USER SUPPLIED +5 TO +12V <

+

A A USER RELAY CONTACTS

3 RLA1
G2R-14-AC120

USER RELAY CONTACTS

TO GROUND, PIN 4 <}
TO USER TALLY, PIN 8 <J

Figure 8 Tally interface to relay.

5.1.3 RS232 Interface.

This loosely follows the pin convention of EIA-561 which is a standard for RS232
on an RJ45 cable. Only TX, RX and Signal ground (pin 4) are implemented. For
the SA-2U the following RS232 parameters apply:

e 115Kbaud
e 8 Bits, no parity
e 1 Stop bit.
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5.2 On-Board automation protocol.

5.2.1 Implimentation on RS232

A simple text based protocol has been implemented on the RS232 interface. All
text strings are shown in inverted commas; do not include them in the actual
command sent. Each byte within a text string must be sent within 10mS of each
other or the command will time out. This on-board protocol is not the same as the
geNETics protocol. Refer to the geNETics protocol in section 6 (Product
Automation) of the etherbox manual. GeNETics protocol is used to control a
number of processor cards using one connection.

The command set is as follows:

Command Meaning Example hex string

‘MS” Master Show. Show 4D,53
selected Cages and
User Controls.

“‘MH” Master Hide. Any 4D,48
selected Cages and
User Controls will be

hidden.

“M1” Recalls User 4D, 31
Presetable Memory 1.

“M2” Recalls User 4D,32
Presetable Memory 2.

“M3” Recalls User 4D,33
Presetable Memory 3.

‘M4 Recalls User 4D,34

Presetable Memory 4.

A response will occur within 100mS of the command. The responses are as
follows:

Response Meaning Hex string
“‘OK” Command was understood and will implement. | 4F,4B
“‘EQ” Command timed out. 45,30
“E1” Error 1. Unknown command. 45,31
‘E2” Error 2. Next Logo number is not in range. 45,32
‘E3” Error 3. Logo has been asked to fade down 45,33

when it is down already, or up when it is up

already
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5.3 geN€Tics Automation Protocol Parameter table.

This is the Automatically extracted parameters for the SA-2U. This is used for the

generic geN€Tics automation protocol. See etherBox manual for a full

description of its usage.

Menu

0

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

36

37

38

Access

R/W

N/A

N/A

N/A

N/A

N/A

N/A

N/A

R/W

R/W

N/A

N/A

RW

R/W

RW

N/A

R/W

R/W

N/A

N/A

RW

R/W

RW

N/A

RW

R/W

N/A

N/A

R/W

R/W

R/W

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

Text
{Master{Contrl{# }
[Gr]

[Gr]

[Gr]

[Gr]

[Gr]

{Mems
HResets{Upgrde}
[Gr]

# 3
{Cursor}{Style=H# }
[Gr]

[Gr]

{Colour{  }# }
{Alpha{  K# % }
{Centrel{  }# 1}
[Gr]

# 3
{Cursor}{Style=H# }
[Gr]

[Gr]

{Colour{  }# }
{Alpha{  K# % }
{Centrel{  }# 1}
[Gr]

# 3
{Cursor}{Style=H# }
[Gr]

[Gr]

{Colour{  }# }
{Alpha{  K# % }
{Centrel{  }# 1}
[Gr]

[Gr]

[Gr]

[Gr]

[Gr]

[Gr]

[Gr]

{ X X )

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

Up

N/A
N/A
N/A
N/A
N/A
N/A
N/A
Variable
5
N/A

N/A

128

N/A
Variable
5

N/A

N/A

128

N/A
Variable
5

N/A

N/A

128

N/A
N/A
N/A
N/A
N/A
N/A
N/A

N/A

Lev Txt1 Txt2 Txt3 Txt4 Txt5 Txt6 Txt7

A = Hide Show

A Off Dash 1 Dash 2 Thick Thin Solid

A White Yellow Cyan Green Magnta Red Blue

A Off On

A Off Dash 1 Dash 2 Thick Thin Solid

A White Yellow Cyan Green Magnta Red Blue

A Off On

A Off Dash 1 Dash 2 Thick Thin Solid

A White Yellow Cyan Green Magnta Red Blue

A Off On
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Black

Black

Black



39

40

41

42

43

44

45

45

46

47

48

48

48

49

49

50

50

51

51

52

53

54

55

56

57

57

58

59

60

60

61

61

62

62

63

64

65

66

67

68

69

70

71

72

73

74

N/A

R/W

R/W

R/W

N/A

R/W

R/W

R/W

RD

N/A

RW

RD

RD

R/W

R/W

R/W

R/W

R/W

RW

R/W

R/W

R/W

N/A

R/W

R/W

R/W

N/A

N/A

R/W

RD

R/W

RD

RD

RD

N/A

R/W

R/W

R/W

N/A

N/A

N/A

N/A

N/A

R/W

RW

R/W

[Gr]
{Colour{ H# }
{Alpha ¥

{Cursor}{Style=}# }

H# %}

[Gr]

{ TEXT {HEIGHT}# }
{Adjusti{A=# }

{B=# }

{ TEXT {HEIGHT}{= #
L

[Gr]

# 3

{s# }
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75 NA K ¥} N/A N/A A

76  RW %> {Mem1}{# 1} 0 1 A Recall DONE
77 RW {%> KMem2}# } 0 1 A Recall DONE
78 RW %> {Mem3}# } 0 1 A Recall DONE
79 NA [Gr] N/A N/A A
80 RW %> {Mem4}# } 0 1 A Recall DONE
81 RW {%> KMem5}# } 0 1 A Recall DONE
82 RW %> {Mem6 }{# } 0 1 A Recall DONE
83 NA [Gr] N/A N/A A
84 RW %> {Mem1}{# } 0 1 A Save DONE
85 RW {%> KMem2}# } 0 1 A Save DONE
86 RW %> {Mem3}# } 0 1 A Save DONE
87 NA [Gr] N/A N/A A
88 RW %> {Memda}# } 0 1 A Save DONE
89 RW {%> KMem5}# } 0 1 A Save DONE
90 RW %> {Mem6 }{# } 0 1 A Save DONE
91 NA [Gr] N/A N/A A
92 RW # } 0 1 A Set As IWAIT!
93  RW @ ) 0 1 A ReBoot  IWAIT!
94 NA {FACTRYKRESETI{!!I}  N/A N/A A
95  N/A [Gr] N/A N/A A
9%  NA {START?{ X 1} N/A N/A A
{ ARE J{ YOU
97  NA I{SURE?]} N/A N/A A
98 RW # } 0 1 A YES OK!
99 NA [Gr] N/A N/A A
{UPGRDE{SOFTWRY
100 N/A NOwW! } N/A N/A A
101 N/A { ¥ X 1} N/A N/A A
102 N/A {RESETSK X } N/A N/A A
103 N/A [Gr] N/A N/A A
104  N/A {START?{ X } N/A N/A A
{ ARE J{ YOU
105  N/A I{SURE?]} N/A N/A A
106 RW # } 0 1 A YES
107 N/A [Gr] N/A N/A A
108 RW {CgeTal}{Box=#} 0 16 A
108 RW {Tal=#} 0 99 B
109 N/A [Gr] N/A N/A A
110  N/A [Gr] N/A N/A A
111 N/A [Gr] N/A N/A A
112 RW {Onscrn}{Text= X# } 0 3 A Off Small Medium Large
113 R/W {Aspecti{Type=}# } 0 2 A Both Stndrd Wide
114 RW {Aspecti{Ratio=}{# } 1 15 A
115 N/A [Gr] N/A N/A A
116 N/A { XThere}{ } N/A N/A A
117 N/A { HsNo¥ } N/A N/A A
118  N/A { XVideo¥ } N/A N/A A
119 N/A { Knput¥ } N/A N/A A
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{sa_2hd}FILE }TIMES
}

120 N/A N/A N/A A

{IS UPG}{IS RECKOUT
IN}

121 N/A N/A N/A A
{RADINGHEIVED }3

122 N/A MINS} N/A N/A A

123 N/A JFNOYIT X } N/A N/A A

5.4 The default set of cages for the SA-2U VI1.50

Cage,Descrl,Descr2,Descr3, H, V, T, B, L, R

No ,Video ,Found , 0, 0, 0, 0, 0, 0
2 16:9 ,S.Actn,1080% ,1920,1080, 37,1044, 88,1831
3 16:9 ,S.Cptn,1080iF ,1920,1080, 54,1027, 210,1709
4 16:9 ,A_Edge,1080i1 ,1920,1080, 1,1080, 22,1896
5 169p43,S.Actn,1080if ,1920,1080, 37,1044, 303,1616
6 169p43,S.Cptn,1080i1 ,1920,1080, 54,1027, 350,1569
7 169p43,A_Edge, 10801 ,1920,1080, 1,1080, 257,1662
8 169p14,S.Actn,1080if ,1920,1080, 37,1044, 210,1709
9 169p14,S.Cptn,1080iF ,1920,1080, 54,1027, 303,1616
10 169pl4,A.Edge,1080i ,1920,1080, 1,1080, 140,1779
11  43p149,S.Actn,1080i ,1920,1080, 108, 973, 116,1803
12  43p149,S.Cptn,1080i ,1920,1080, 124, 957, 210,1709
13  43p149,A.Edge,1080i ,1920,1080, 75,1006, 22,1896
14  4:3 ,S.Actn,1080iF ,1920,1080, 54,1027, 116,1803
15 4:3 ,S.Cptn,1080i ,1920,1080, 108, 973, 210,1709
16 4:3 ,A_Edge, 10801 ,1920,1080, 1,1080, 22,1896
17 Clean ,Apert.,10801 ,1920,1080, 9,1071, 15,1903
18 Digit.,Edge ,1080i ,1920,1080, 1,1080, 0,1919
19 16:9 ,S.Actn,720p ,1280, 720, 25, 696, 59,1220
20 16:9 ,S.Cptn,720p ,1280, 720, 36, 684, 140,1139
21 16:9 ,A_Edge,720p ,1280, 720, 1, 720, 15,1263
22  169p43,S.Actn,720p ,1280, 720, 25, 696, 202,1077
23  169p43,S.Cptn,720p ,1280, 720, 36, 684, 233,1045
24  169p43,A.Edge,720p ,1280, 720, 1, 720, 171,1107
25 169pl4,S.Actn,720p ,1280, 720, 25, 696, 140,1139
26  169pl4,S.Cptn,720p ,1280, 720, 36, 684, 202,1077
27 169pl4,A_Edge,720p ,1280, 720, 1, 720, 93,1185
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28  43pl149,S.Actn,720p ,1280, 720, 72, 648, 77,1201
29  43p149,S.Cptn,720p ,1280, 720, 83, 638, 140,1139
30 43pl49,A_Edge,720p ,1280, 720, 50, 670, 15,1263
31 4:3 ,S.Actn,720p ,1280, 720, 36, 684, 77,1201
32 4:3 ,S.Cptn,720p ,1280, 720, 72, 648, 140,1139
33 4:3 ,A_Edge,720p ,1280, 720, 1, 720, 15,1263
34 Clean ,Apert.,720p ,1280, 720, 6, 714, 10,1268
35 Digit.,Edge ,720p ,1280, 720, 1, 720, 0,1279
36 4:3 ,S.Actn,PAL , 720, 576, 29, 547, 44, 676
37 4:3 ,S.Cptn,PAL , 720, 576, 57, 519, 79, 641
38 4:3 ,A_Edge,PAL , 720, 576, 1, 576, 9, 712
39 16:9 ,S.Actn,PAL , 720, 576, 21, 555, 34, 686
40 16:9 ,S.Cptn,PAL , 720, 576, 31, 545, 79, 641
41  16:9 ,A.Edge,PAL , 720, 576, 1, 576, 9, 712
42  169p43,S.Actn,PAL , 720, 576, 21, 555, 114, 606
43  169p43,S.Cptn,PAL , 720, 576, 31, 545, 132, 588
44  169p43,A.Edge,PAL , 720, 576, 0, 576, 97, 623
45 169p14,S.Actn,PAL , 720, 576, 21, 555, 79, 641
46  169pl4,S.Cptn,PAL , 720, 576, 31, 545, 114, 606
47  169pl4,A.Edge,PAL , 720, 576, 1, 576, 53, 667
48 43p149,S._Actn,PAL , 720, 576, 57, 519, 44, 676
49  43pl49,S.Cptn,PAL , 720, 576, 67, 509, 79, 642
50 43pl49,A_Edge,PAL , 720, 576, 41, 535, 9, 712
51 Digit. ,Edge ,PAL , 720, 576, 1, 576, 0, 719
52 4:3 ,S.Actn,NTSC , 720, 487, 26, 464, 37, 684
53 4:3 ,S.Cptn,NTSC , 720, 487, 50, 441, 73, 648
54 4:3 ,A_Edge,NTSC , 720, 487, 3, 486, 9, 712
55 16:9 ,S.Actn,NTSC , 720, 487, 26, 464, 37, 684
56 16:9 ,S.Cptn,NTSC , 720, 487, 50, 441, 73, 648
57 16:9 ,A_Edge,NTSC , 720, 487, 3, 486, 9, 712
58 169p43,S.Actn,NTSC , 720, 487, 26, 464, 117, 604
59 169p43,S.Cptn,NTSC , 720, 487, 50, 441, 144, 577
60 169p43,A_Edge,NTSC , 720, 487, 3, 486, 97, 623
61 Digit.,Edge ,NTSC , 720, 487, 1, 487, 0, 719
62 Digit.,Edge ,D.Cine,2048,1080, 1,1080, 0,2047
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64,1983

1,1080,

HD1080,D.Edge,D.Cine,2048,1080,

63
64
65
66
67

0,2047

2.39:1,D.Edge,D.Cine,2048,1080, 112, 968,

Blank ,Blank ,Blank ,

0

0,

68
69
70
71

72
73
74
75
76
77
78
79
80
81

82

83
84

85
86

87

O O O O O O O o o o

88
89

90

o O ©O O O O

O O ©O O O O

O O ©O ©O O O

O O ©O ©O O O

o O ©O O O O

91
92
93
94
95
96

o

97
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98 . . , 0, 0, O, O, O, O
99 s . ’ 0, 0, 0, 0, 0, 0
100 , , , 0, 0, 0, 0, 0, 0

5.5 CageUploader Software

The CageUploader software allows the editing, loading, capturing, addition and
deletion of cages. However, if Factory Reset (menu number 96) is performed any
changes will be lost as the default cages (see section 5.4) will be reloaded.

el Cage Manager
File Edit Tools

Cages
Cage Mumber E EI:
Cage Mame 16:9 B charz

S.hcth E chars

1080 E chars

Video Standard | 1080i -

Horizontal Res 1920
WVertical Res 1080

Top 7 =
Battamn ’m
Left B =]
Right 1831 ==

Done

Figure 9 Cage Uploader Software

5.5.1 Connecting CageUploader

You can connect directly to the unit using the RJ-45 connector on the rear of the
actual SA-2U card module. A specialised cable will be required. The connections
for this are as follows:

RJ45 pin number 9W D type (Fem) pin number
4 5
5 2
6 3
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5.5.2 Defining New cursors.

Once connected using this cable run CageUploader. Under the “Tools->Comm
Port Settings” menu, select the “SA-2U card” drop down option and select the
correct COM PORT for your computer. The NID does not matter. Then under
“Edit” select “Add/Edit Cage”. At this point you can use the “cage number” field to
step through the current Safe Areas installed. You will see a representation of
this appear on the right hand side of the application. You will need to step as far
as cage 123 to find a “Spare” location to define a new safe area. You next need
to select the video standard that the sake area is defined in. You can then name
the safe area and define the Pixel and line numbers (in progressive format).

5.5.3 Defining New video standards.

The SA-2U unit is ready for emerging line standards and it is possible to define a
new line standard if the situation arises. Select “Edit->Add/Edit Video Standard”.
Scrolling through the standards you will see the ones already defined. Scroll to
the next “Blank” to add a new video standard.

5.5.4 Upload/Download/Saving/Loading

Under the File menu you can Open either from a computer file or from a device
(“device” meaning uploading the current safe areas stored in an SA-2U unit).
Similarly you can save the current set of safe areas to a file or to a device
(“device” meaning downloading the safe areas to an SA-2U).

5.6 Technical Specification.

When in SDI mode:

SDI Inputs 2 Input to SMPTE 259M
(270 Mbps, 800mV p-p£10% into 75Q) | Link A In, Link B In
SDI Outputs 3 Outputs to SMPTE 259M
(270 Mbps, 800mV p-p+£10% into 75Q) | Link A Out1, Link A Out2, Link B Out
SDI cable equalisation At least 200m of PSF 1/3
Return loss better than 18dB, 5 MHz —
270 Mhz

When in HD-SDI mode:

HD-SDI Inputs 2 Input to SMPTE 292M, (Dual Link
(1.845 Gbps, 800mV p-p£10% into SMPTE 372M)
75Q) Link A In, Link B In
HD-SDI Outputs 3 Outputs to SMPTE 292M, (Dual Link
(1.485 Gbps, 800mV p-p£10% into SMPTE 372M)
75Q) Link A Out1, Link A Out2, Link B Out
HD-SDI cable equalisation At least 100m of Belden 1694A
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General:

Ancillary Data

Passes all ancillary data in vertical and
horizontal blanking except for CRC
reclalculation.

Control Surfaces

Option of local or remote FP-9 control
panel.

Chassis

FB-9€ etherBox 1U enclosure

Supported Formats

720x576/50i
720x487/60i
720x507/60i
1280x720/23.98p
1280x720/24p
1280x720/25p
1280x720/29.97p
1280x720/30p
1280x720/50p
1280x720/59.94p
1280x720/60p
1920x1080/23.98p
1920x1080/23.98psf
1920x1080/24p
1920x1080/24psf
1920x1080/25p
1920x1080/50i
1920x1080/29.97p
1920x1080/59.94i
1920x1080/30p
1920x1080/60i
2048x1080/23.98p
2048x1080/23.98psf
2048x1080/24p
2048x1080/24psf

Delay

<10us

Power Supply

100-240v AC. Less than 50W power
consumption with 6 SA-2U units
installed.

FB-9€ Dimension Width 442mm
Height 44mm
Depth 300mm
Weight <3Kg
Temperature <25°C ambient, <55°C internal
Humidity Recommended 40 to 55%

Limits 20 to 80%
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